Part 6: Reports Menu

ES&S

Reports | Suspended

Precinct ]
Election ]
Canwvass ]
Leg 2

Part 6 contains information about the following topics.

< Chapter 31: Precinct and Election Report Options
< Chapter 32: Canvass Report Options
< Chapter 33: Log
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Chapter 31: Precinct and Election Report Options

This section will explain the different report options that you can select for the reports.

1.

From the Reports menu and click the report you want to generate.
< Precinct

e EL30, Precinct Report: A Precinct Summary Report is a list of individual
precincts and contest results. Customize the Precinct Summary Report by
selecting the individual contests and precincts that are included. You can also
print a Precinct Summary Report for individual reporting groups.

e EL30A, Prec Report—Group Detail: The Precinct Summary Report with Group
Detail is similar to the Precinct Summary report. You can use it to print totals
for up to fourteen active reporting groups in addition to Election Totals.

% Election

* EL45, Election Summary Report: An Election Summary Report lists the total
number of votes received by each candidate/question and the percent of the
total vote won by each candidate/question in your election.

* EL45A, Election Summary with Group Detail: Generate an Election Summary
with Group Detail to print totals for up to fourteen active reporting groups in
addition to election totals.

This will open up the window to select the options for the reports.

Selection Tab

ES&S

On the Selection tab, choose

the contests and/or Selection lHeadmgs] Opﬂons] Reporting Group | Print Which Groups

precincts that you want to Al

appear on your report. ¢ Contest/Precinct

* Select All to print all | e, |
|

contests and precincts

" File | J
* Select Contest/Precinct Apply
to generate a report for Output Destination
specific contests or -
precincts. Take the o

following steps to select
specific contests or
precincts.

oK Cancel
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a. Type a contest
sequence number in
the Contest field or
click Contests to
open the Contest
window

b. Select from the
list of available
contests. To select
several contests,
press and hold the
Ctrl key while
clicking the contests
you want to select.
There is a limit of 71
contests on this
screen.
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0001 REGISTERED VOTERS - TOTAL
0002 BALLOTS CAST - TOTAL

0003 BALLOTS CAST - NONPARTISAN
0004 BALLOTS CAST - DEMOCRATIC
0005 BALLOTS CAST - BLANK

0101 UNITED STATES SENATOR

0102 UNITED STATES CONGRESS, DISTRICT 2
0103 GOVERNOR

0104 SECRETARY OF STATE

0105 STATE TREASURER

0106 SECRETARY OF STATE

0107 ATTORMEY GENERAL

AAAA ARG ATV S R

Refer to the EL45, Election Summary Report heading in this chapter for information
about setting up an .A01 file if you want to select more than 71 contests.

c. Type a precinct
identification
number in the

Precinct field or click = | Precincts

Precincts to open
the Precincts
window.

d. Select from the
list of available
precincts. To select
several precincts,
press and hold Ctrl
while clicking the
precincts you want
to select. There is a
limit of 71 precincts
on this screen.

0001 PRECINCT 1

0002 PRECINCT 2
0003 PRECINCT 3
0004 PRECINCT 4
0005 PRECINCT &
0006 PRECINCT &
0007 PRECINCT 7
0008 PRECINCT 8
0009 PRECINCT 9

Refer to the Set up an .A01 File from Which to Print in this chapter for information
about setting up an .A01 file if you want to select more than 71 contests and

precincts.
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* Select File to generate a report from an existing election file that you have
created. Select an available file from the list or create a new file.

Headings Tab

5. Click the Headings tab
to enter the
information that you Canvass Center Heading
want to appear on your ||
report headings. |

Selection Headings lOptions] Reporting Group | Print Which Groups

6. Enter up to three lines

of identification text Canvass Left Edge Heading Line No. Canvass Right Edge Heading
that you want to SUMMARY REPORT 1

appear at the top
center of your reportin

the Canvass Center Reset Use For This Run Only| Apply
Heading fields.
7. Enter the text that OK Cancel

appears at the top left
of your report in the Canvass Left Edge Heading field.

8. Enter the line number on which you want this heading to print (1, 2, or 3) in the Line
No. field.

NOTE: If you choose to print something on line 3, the time/date stamp and the
report number and page will print on the fifth line, instead of the fourth.

9. Enter the text that appears at the top right of your report in the Canvass Right Edge
Heading.

10. Click Reset to clear your settings. Click Use For This Run Only to only use your
headings with the next report that you print. Click Apply to use your headings for all
reports of the same type.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
ES&S February 13, 2013



Options Tab

11. Click the Options tab, and
choose the options you

Chapter 31: Precinct and Election Report Options

Selection | Headings Options | Reporting Group] Print Which Groups]

83

want to include on the [ dnclude over/under reporting?  Percentages: [Cans % bassd on votes castNooviun %« |

v Include time/date stamp? :
. Number of copies:

report ™ Include page number? B 0
[ Include precincts reported line?
": Precinct terminology [FRECINCTS
’_ :l
™ Always use RV totals?
[ Print contest totals? Print multiple copies in what seq.? [N jnons) -
[ Print candidates in vote seq.?
[ Print 1up format?
[ Exclude local contests?

Reset Use For This Run Only Apply |
oK Cancel |
Option Description Active for

Include over/
under
reporting?

to include over-vote and
under-vote totals in your report.

EL30, Precinct Report

EL30A, Prec Report—Group Detail

EL45, Election Summary Report

EL45A, Election Summary with Group Detail

Include date/

Include the date and time your

EL30, Precinct Report

time stamp report was generated at the top left | EL30A, Prec Report—Group Detail
of the first page of your report EL45, Election Summary Report
EL45A, Election Summary with Group Detail
Include page Includes page numbers EL30, Precinct Report
number? EL30A, Prec Report—Group Detail
EL45, Election Summary Report
EL45A, Election Summary with Group Detail
Include The number of precincts counted EL45, Election Summary Report
Precincts on your report. This will include a EL45A, Election Summary with Group Detail

reported line

line for each contest and for
example will show, (WITH 3 OF 9
PRECINCTS COUNTED)

Print totals

Displays election totals without

Not available

only (no including precinct details.

detail)

Summarize Combines the absentee numbers Not available
absentee for each of your precincts into a

precincts? single absentee total.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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Option

Description

Active for

Use seq. page

Numbers your pages sequentially. If

Not available

numbering? itis not selected, the number of the
first contest on the page, the last
contest on the page and the page
number within the contest set,
determines your page number.
Separate Organizes your results by party in Not available
Reports by precinct sequence order. When
Party? Separate Reports by Party is not
selected, your results are organized
by precinct in party sequence order
Always use Unchecked - will only show the EL45, Election Summary Report
R/V totals? registered voter totals for precincts EL45A, Election Summary with Group Detail
that have been counted.
Checked - will show the registered
voter totals on the report for all
precincts in the election.
Include only Includes only counted precincts in EL30, Precinct Report
counted the report. EL30A, Prec Report—Group Detail
precincts?

Print contest

Totals line for each contest in the

EL30, Precinct Report

totals? report. EL30A, Prec Report—Group Detail

EL45, Election Summary Report

EL45A, Election Summary with Group Detail
Print Prints the candidates in vote EL45, Election Summary Report

candidates in
vote

sequence, listing candidates in
order of the greatest vote tally first.

EL45A, Election Summary with Group Detail

sequence? If this option is not selected, the
report will print in the same order
that the candidates occur on the
ballot (or in home rotation if
candidates rotate).
Print 1 up If selected will print the report in EL30, Precinct Report
Format? one column format. If it is not EL45, Election Summary Report
selected it will print the contest in
two columns.
Exclude local Excludes totals for local contests EL45, Election Summary Report
contests? from the report EL45A, Election Summary with Group Detail
ELECTION REPORTING MANAGER USER GUIDE v. 8.6
February 13, 2013

ES&S

84



Chapter 31: Precinct and Election Report Options

Option

Description

Active for

Percentages

* Select No Cand% - No OV/UN%
- to omit all percentages from
your report.

* Select Cand % Based on Votes
Cast No. ov/uv % - to print the
candidate percentages based
on the number of votes cast in
that contest, not including over
and under votes.

If Include over/under reporting? is
checked these additional options
are able to be selected:

® Cand % based on votes
cast-With ov/un % - to print the
candidate percentages based
on the number of votes cast in
that contest, including over and
under votes.

® Cand % based on elig.
votes-With ov/un % - to print
the candidate percentages
based on the number of eligible
votes cast in that contest,
including over and under votes.

EL30, Precinct Report
EL30A, Prec Report—Group Detail
EL45, Election Summary Report

EL45A, Election Summary with Group Detail

Number of
copies

Sets the number of reports that you
would like to generate.

EL30, Precinct Report
EL30A, Prec Report—Group Detail
EL45, Election Summary Report

EL45A, Election Summary with Group Detail

District
control file
name

The District Control File is located in
the \elecdata folder and has a .dst
extension.

Refer to the Create a District
Control File heading in this chapter
for information about how to
create a district control (.dst) file if
ES&S did not create one for you.

Not available

Precinct
terminology

Enter the term in the field used by
the jurisdiction to describe
precincts. Example: Wards, Election
Districts.

EL45, Election Summary Report

EL45A, Election Summary with Group Detail

Prt. Cert

Controls how the certification
message appears on the reports.

Not available

Print multiple
conts on same

pg

Controls how contests appear on
your reports

Not available

85
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Option Description Active for
Print Multiple | Controls the order in which reports EL30, Precinct Report
Copies in are printed EL30A, Prec Report—Group Detail
what seq? . ELA5, Election Summary Report
* N - Print one copy of the report EL45A, Election Summary with Group Detail
® P - Print multiple copies of each
precinct’s results before
printing results for the
® R - Print a copy of the entire
report and then repeat the
process for the next
Reporting Group Tab

ES&S

12. On the Reporting Group tab,

select the group you want to

Selection Headmgs] Options Reporting Group l Print Which Groups]

rint.
p Current Report Group:
Election Day
Select ELECTION TOTALS to ELECTION TOTLS Aosentee
print a total of all your
reporting groups. Select one of
the other groups you defined
to print a total of only that
group.
oK Cancel

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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Print Which Groups Tab

In the Report Column, you can
change the order of the
groups. Put the number in the
column in the order you would
like it to show on your reports.
Enter “0” if you do not want a
column to appear on your
report. In the Column Heading,
if you want to change the text
you can type it here up to 9
characters.

Chapter 31: Precinct and Election Report Options 87

Selection Headings] Options] Reporting Group  Print Which Groups

Feport
Defined Groups CDE;Eann Colurnn Heading
1. Election Day Elec Day
2. Absentes | 2 |aBs
oK | Cancel |

Refer to Chapter 8: Create ERM from XML Files for information about reporting
groups and how to create them.

Output Destination

ES&S

13. Return to the Selection
tab, and select an Output
Destination.

* Click Disk if you want
to view the report on
your PC. You have the
option to print the
report after you view
it.

e Click Printer if you
want to send the
report directly to a
printer without
viewing it.

*  Click Internet to print

Selection lHeadings] Options] Reporting Group | Print Which Groups

o All

" Contest/Precinct

|

|
" File | J

Apply
Qutput Destination

~
~
~

QK Cancel

the report in HTML format.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
February 13, 2013



Chapter 31: Precinct and Election Report Options 88

14. f you selected Printer as an Output Destination, the report will automatically print
when you click OK.

15. If you selected Disk, the report file will load —
and will show the report file that you have i Elecion Suppag
selected. Click OK to load the The Report File Listing is completel
Utility window. Print file is:

EL45LST

16. Select your report from

the Report File Utility. = | Report il Uticy

. Report Timesta
* EL30 - Precinct o e
ELal Precinct. Eeport 1072172011 04:01:24 PH
Report EL304  Precinct Report-group detail 102472011 12:33:32 P
EL45 Election Summary 10-24-2011 12:31:21 FH
. EL45h  Election Summary-group detail 1072472011 12:33:23 P
* EL30A Precinct
Report-group detail
* EL45 - Election
Report
* EL45A - Election
Report-group detail
i X Display Print Delete Copy Cancel
17. Click the appropriate

button to perform one
of the following actions.

* Click Display if you want the report to appear on your PC for immediate viewing.

e Click Print to send the report to the printer.

NOTE: The Print option only works with a printer connected to the PC through the
@ LPT1 port. If you are using a USB printer, click Copy and save the report as a .txt file.
Then, open the .txt file and print it.

* Click Delete to delete the selected report.
* Click Copy to copy the report to another location or media.

¢ Select Cancel to return to the main menu.

Display the Report

When you display a report, the following menu appears at
the top left of the report screen. " File Edit View Search

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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< The File menu you can select Exit to exit out of the Report File

Utility Screen. File | Edit View

% Exit

Edit | View Search
L\x’ Set Font Size...

< From the Edit menu, click Set Font Size... to change the
font size of the report.

Click on the drop down menu to select the font size.
After you select the font size you want, click OK to change
the font size report that you currenlty have displayed.

Font size:

@ [ oK |
Cancel

< Click View to move around within the report. Use the
following commands:

* To move to the first page of the report, select First View | Search
Page or press CTRL + F. First Page Chrl+F

* To move to the last page of the report, select Last Last Page Ctrl+L

Page or press CTRL + L. Next Page  Ctrl+N

* To move forward one page, select Next Page or Previous Page Ctrl+P

press CTRL + N. Goto Page.. Ctrl+G

* To move back one page, select Previous Page or
press CTRL + P.

* To move to a specific page, select Go to page or
press CTRL + G and then enter the page number.

< Click Search and select Find to locate a particular
name or string of text. The Find window appears. Llrlsea“h
Find...

Find Mext F3

Enter the text string and click Find. Press
F3 or click Find Next to find the next
instance of that string. The program will
then find and highlight it

Find what:

Cancel

@ NOTE: The Find option is case sensitive.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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Set up an .A01 File from Which to Print

When generating a report
by specific contests and/or
precincts, there is a limit of
71 contests or precincts to
be selected on the report
screen. To select more than
that number, create an .A01
text file from which to print.
Take the following steps to
set up the file.

1. On the Selection tab of
the report, click New
next to the File list to
open the Change
Precinct/Contest
Selection File window.

2. Click New on the Change
Precinct/Contest Selection
File window.

3. The report option window
will open to the Headings
tab.

4. Enter up to three lines of
identification text that you
want to appear at the top
center of your report in
the Canvass Center
Heading fields.

# | Print Election Summar

90

Selection l Headings ] Options ] Reporting Group] Print Which Groups ]
Al
" Contest/Precinct
« File | j
£pply

Owtput Destination
(" " Disk
L + Printer
L " Internet

Apply
DK Cancel

# | Change Precinct/(

Files:

Change
Cancel

# | Print Election Canvas

Headings lContests] Precincts] Total ] Sequence

Canvass Center Heading

|ANY COUNTY, USA

|GENERAL ELECTION

[NOVEMBER 8, 2011

Canvass Left Edge Heading

Canvass Right Edge Heading

|UNOFFICIAL |

Cancel

Save As

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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You can make any necessary changes and click Apply to save these changes for each
additional printing of this report. Any changes you make to the headings will not
appear on other reports.

5. Enter the text that appears at the top left of your report in the Canvass Left Edge
Heading field.

g NOTE: The Line No. field does not appear on the Headings tab for all reports.

6. Enter the text that appears at the top right of your report in the Canvass Right Edge
Heading.

7. Click the Contests tab to open
the following window.

Headings Contests |Precincts | Total | Sequencel

8. Click the Contest tab. The ~Contests
Contests window appears. 1109 _ Contest_|

Cancel

9. Select the contests that you
want to include in your report
from the list.

0001 REGISTERED VOTERS - TOTAL

0002 BALLOTS CAST - TOTAL

0003 BALLOTS CAST - REPUBLICAN

0004 BALLOTS CAST - DEMOCRAT

0005 BALLOTS CAST - NONPARTISAN

0006 BALLOTS CAST - BLANK

0100 UNITED STATES SENATOR

0103 REPRESENTATIVE IN CONGRESS, 18TH DISTRICT
0104 UNITED STATES SENATOR

0105 GOVERNOR

0107 MAYOR,

0108 BOARD OF COUNTY COMMISSIONERS DISTRICT 3

DK

NOTE: To select multiple items in a list hold down the CTRL key and select individual
Q items. To select a group of items from a list hold down SHIFT and drag your cursor
over the items that you want to select.

10. Click OK in the contest list to continue. The Print Election Canvass window reappears
with the selected contest numbers in the Contests field. Press Enter to save your
selections and move the contests to the bottom window.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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11. Click the Precinct tab. The

Precinct window appears. = | Print Election Cany ==

Headingsl Contests Precincts |T0ta| | Sequencel

~Precincts

| Precinct. . |

12. Select the precincts that you
want to include in your report

from the list. 0001 PRECINCT 1
. . ) 0002 PRECINCT 2
13. Click OK in the contest list to PUISESE e

0004 PRECINCT 4

continue. The Print Election 0005 PRECINCT 5
0006 PRECINCT 6

Canvass window reappears with 0007 PRECINCT 7
. 0008 PRECIMNCT 8
the selected contest numbers in 0009 PRECINCT 9
the Precincts field. Press Enter
to save your selections and
move the contests to the 0 Cancel _|

bottom window.

14. To create groups to view election results for groups of precincts, click the Total tab to
open the following window.

(751 Print Election Cany =)
15. Press TAB to move to the

Associated Text field and Headings | Contests I Precincts Total |Sequence |
enter text that identifies — S
your group (“Precincts [15 [Precincts Precinct... |
105-110,” for example). Page Uy |
Press Enter to save your -
selections and move the [P Do
contests to the bottom
window.

16. Click OK or Save As and
enter a file name in the
New filename field. oK Cancel Save As

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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17. Enter your .A01 file name in the New
filename field, and click OK. The file name
will appear in the File field on the Selection
tab. Mew filename: IANYCDUNT

18. Click OK to save your file and return to the
report options window or click Cancel to
return to the main screen without saving
your settings.

Cancel

4 The Sequence tab is used only in Hawaii. Repeat steps 7-9 for the Sequence tab if
@ it is available.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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EL30, Precinct Report
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EL30A, Prec Report—Group Detail

Chapter 31: Precinct and Election Report Options

T=-GROUF DETAIL

1 FQECINCT 1

uL 5&

1
[ ANT
&L

i

fotal .
Ovar H':t:- .
Under Votes .

DATE: 8495609 04:25 PH

'ul'lb‘.l' - TO'ILL .

?%%%@

EEEEPI
‘?« Bl

R

S

Fd

=

RIBHERS

Election Day

0.0

Absentee

5
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EL45, Election Summary Report

M fL45 Page 101

Fls [t View Sewth

SUMMARY REPORT HNY COUHTY UNOFFICIRL
GEMERAL ELECTION
HOVEMEER &, 2008

RUM DATE : B&/87/09 10:17 AH REPORT-ELLS
VOTES PERCENT
PRECIMCTS COUNTED (OF 2y . . . . . 2 lpb.pa
REGISTERED VOTERS - WTHL a0 o ¢ 10, 000
BRLLOTS CAST - TOTHAL. 5 o o ¢ 8. 760
BRLLOTS CRST - BLARK. . . . . . . 1]
VOTER TURMOUT = TOTAL . . . . . . 87.60
VOTER TURNOUT - BLANE . . . . . .
Gowernor
[VOTE FOR) 1
GEORGE WASHINGTOM (REP). J1.600  35.19
THOMAS JEFFERSOM (DEW) . 2.550  2.93
ABRAHAM LINCOLN (LAE] . 1.41% 13.83
AMDREY JACKSON (COu) 125 7.09
ROBERT E. LEE (FRE) . 70 9.57
BEN FRAKNKLIN (COH) . 520 5.13
JOHN ADAKS ] . 290 286
ULYSSES &, NT (COMY s | 2.15
FRANLEIH ROGSEVELT (SLE) 200 1.96
TEDDY ROOSEVELT lﬁik!] 150 1.47
Write-In, . . 20 g o0 o o ¢ 25 L2k
Total . . . . . . . . . 10,230
Dver Votes . . . . 1@
Under Votes . 20
Emirnller
(VOTE Fi)

ALAT E. SIE VENSON (DEM)
CHESTER A. ARTHUR [REP).
CALVIN COOLIDGE {LIR)
JOHN ©, BRECKENRIDGE ILHE]
SPIRD AGNEW [SHED,

= et e P
22282
=
[=—1--]
=
=
W
L=}

MARTIN VAN BUREN [EI]H} 59.99
Write=Im, . . . . 168 1.57
Total e e 10,210
Over Yotes . . . . . . . . . 10
Under Voles . . . . . . . . . [}
< |
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EL45A, Election Summary with Group Detail

M EL45Kk Page 1af 2

SUMMARY REPT-GROUP DETRIL ANY COURTY, Us HREPORT-EL&SA
GEHERAL ELECTION
HOVEMEER &, 2008
RUM DATE : B4/87/09 10:19 AM
TOTAL WOTES % Election Day Absentes

PRECINCTS COUNTED (0F 2) . . . . . 2108, 00
REGISTERED WOTERS - TOTAL . . . . . 16, @00
BALLOTS CAST - TOTAL. . . . . . . &, 760 8,500 260
BALLOTS CAST - BLANK. . . . . . . ] ] o
VOTER TURMOUT - TOTAL . . . . . . 87,60
VOTER TURHOUT - BLAWE . . . . . .
Fouernor
(VOTE FOR) 1
GEDRGE WASHINGTOM (REP). . . . . . 3.600 35,19 3,500 100
THOMAS JEFFERSON (DEM) . . . . . . 2,900 246.93 2,908 o
BEN FRARKLIN (COWY . . . . . . . 229 3.13 it 25
JOHN ADAWS (LIR) | Koo 250 244 250 1]
TEDDY ROOSEVELT (SH c e e e 150 1.47 158 L]
FRANLKIN ROOSEVELT 1SLBJ ... 200 1.9 200 1]
ABRAHAN LINCOLH fLRBY . . . . . . 1.415 13.83 1.600 15
ULYSSES 5, GRANT (COM) . . . . . . 220 2.15 200 0
AMDREW JACKSOM (couy. . . . . . . 125 7.09 Fiil 25
ROBERT E. LEE (FRE) . . . . . . . 579 5.57 550 0
Hrite=Im., . . . . . . . . . . 29 2k 208 ]

Total . . . . . . . . . 10,230 9.970 260

Compliral ler

{VOTE FOR) 1
CHESTER A. ARTHUR [REF) 2,850 20.08 2.000 aa
ADLAT E. STEVEWSOM (DEM) 3.100 30,36 3,000 100
HARTIN VAN BUREN (CONY - . . . . . 1.020 9.99 1. 000 “
CALVIN COOLIDGE LIBI S ... 1,530 14.99 1,500 k1]
SPIR0O AGHEW (SHE]. . 1.8:0 10.19 1,000 1]
JOHN . BRECKEMRIOGE IlFIBL 1.3 12.83 1,300 18
Hrite-In .. ... 168 1.57 158 L]

Total . . . . . . . o . 16,210 9,950 260
[ P |
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Chapter 32: Canvass Report Options

ES&S

Take the following steps to generate a canvass

Suspended
report.

Precinct 3

Election 3
Click Reports then Canvass, and select one of L L N [ e
»

. Log MNumber Key-Statistics Only
the fOIIOWIng report' MNumber Key-Districts Only

Candidate Name Heading
Mames and District Totals 4

Block Style

Jurisdictional

Local Office

Precincts Counted/Mot Counted
Precincts Completed Listing
Packs Received Listing

Precincts Processed Listing

Eagle Statistics

EL52, Numbered Key Canvass: Create a Number Key Heading report to list the number of
votes received by each ballot selection sorted by contest identification numbers for each
of your precincts. Customize the report by including over-vote and under-vote totals, the
time and date, the page number and the number of precincts counted. You can also
display the percent of the total votes received by each candidate. The Number Key
Heading report is preceded either by a statistics page or by election statistics printed as
contests.

EL52S, Statistics Canvass: The Number Key Heading—Statistics Only report contains the
total number of ballots cast in your election and the percent of the total ballots that are
cast in each of your precincts. The Number Key Heading—Statistics Only report also
contains statistics for total voter turnout and the percent of the total voter turnout from
each of your precincts.

EL52D Numbered Key-Districts only: The Number Key Heading—Districts Only report is a
summary report, by district, of each office. A district control (.dst) file must exist before
you can generate a Number Key Heading—Districts Only report. The .dst file is usually
created by ES&S and placed in the \elecdata folder.

EL111, Name Heading Canvass: The Candidate Name Heading report contains statistics
for the total number of precincts counted, the total number of votes cast for each
candidate and the percent of the total vote received by each of your candidates.
Candidates are organized by candidate name heading.

Names and District Totals: Two reports are available with this option: EL116, District
Totals Canvass and EL166, District Totals, Election Day A/V Combined. A .dst file must
exist before you can generate these reports. The .dst file is usually created by ES&S and
placed in the \elecdata folder.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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< Select Standard to create the Name and District Totals report, which lists election
totals organized by name headings. The standard report prints results for election day
only.

< Select Election Day/AV Combined to print election day and early voting results with
combined totals.

EL119, Canvass—Block Style: Select the Block Style report to print a report similar to the
Candidate Name Heading canvass with the text enclosed in separate fields similar to a
table.

EL86, Jurisdiction Canvass: Select a Jurisdictional Canvass report to list all of the contests
associated with a specific district in your jurisdiction or to list all of the contests
associated with each of your districts. Use Election Data Manager (EDM) and
ElectionWare Process to define your district codes.

EL60, Local Office Canvass: Select the Local Office report to list the number of votes and
percent of the total vote received by the candidates in your local contests. Organize the
Local Office by precinct or by party. A local office is defined as an office containing district
code PRC.

EL50, Precincts Counted: Select the Precincts Counted/Not Counted report to list the
identification numbers and names of your precincts and to list the precincts that are
counted by ERM.

EL50A, Precincts Completed Listing: Select the Precincts Completed List to print a list of
precincts that have been completed along with their Total Ballots Cast, Total Registered
Voters, and the Turnout Percentage.

EL50D Precinct Processed Listing: Select the Precinct Processed Listing to print a list of
precincts that have been processed. The report includes the Group where the results
were reported, serial number and how many ballots were scanned for each precinct.

Packs Received Listing: This option is no longer supported.

Eagle Statistics: This option is no longer supported.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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Selection Tab

1. On the Selection tab,
choose the contests and/
or precincts that you
want to appear on your

report.

* Select All to print all
contests and
precincts.

¢ Select Contest/
Precinct to generate a
report for specific
contests or precincts.
Take the following

Chapter 32: Canvass Report Options
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Selection ]Headings] Optionsl Reporting Group | Print Which Groups

f+ All
" Contest/Precinct
" File | J
Apply
Qutput Destination
* Preceded by a statistics canvass o Di
" With statistics printed as contests f+ g
" Without statistics " Internet
Apply
oK Cancel

steps to select specific contests or precincts.

a. Type a contest

sequence number in the

Contest field or click
Contests to open the
Contest window.

b. Select from the list of

available contests. To
select several contests,
press and hold the Ctrl
key while clicking the
contests you want to

0001 REGISTERED VOTERS - TOTAL

0002 BALLOTS CAST - TOTAL

0003 BALLOTS CAST - NONPARTISAN
0004 BALLOTS CAST - DEMOCRATIC
0005 BALLOTS CAST - BLANK

0101 UNITED STATES SENATOR

0103 GOVERNOR

0104 SECRETARY OF STATE
0105 STATE TREASURER
0106 SECRETARY OF STATE
0107 ATTORNEY GENERAL

select. There is a limit of 71 contests on this screen.

c. Type a precinct
identification
number in the
Precinct field or
click Precincts to
open the Precincts
window.

ES&S

0102 UNITED STATES CONGRESS, DISTRICT 2

0001 PRECINCT 1

0002 PRECINCT 2
0003 PRECINCT 3
0004 PRECINCT 4
0005 PRECINCT 5
0006 PRECINCT 6
0007 PRECINCT 7
0008 PRECINCT 8
0009 PRECINCT 9

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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2.
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d. Select from the list of available precincts. To select several precincts, press and
hold the Ctrl key while clicking the precincts you want to select. There is a limit of
71 contests on this screen.

* Select File to generate a report from an existing election file that you have
created. Select an available file from the list or create a new file.

Election Report Options for information about setting up an .A01 file if you want to

Refer to the EL45, Election Summary Report heading in Chapter 31: Precinct and
g select more than 71 contests and precincts.

Determine whether you want election statistics to be included on your report, and if
you want to include them, where you want them to print

* Select Preceded by a statistics canvass to include a page of election statistics
before your report information.

* Select With statistics printed as contests to include election statistics in contest
format on your report.

* Select Without statistics to leave election statistics off your report.

Headings Tab

3.

Click the Headings tab to enter the information that you want to appear on your
report headings.

. Selection Headings lOptions] Reporting Group | Print Which Groups
Enter up to three lines of

identification text that you Canvass Center Heading
want to appear at the top |
center of your report in the
Canvass Center Heading
fields.

You can make any
necessary changes and
click Apply to save these
changes for each additional
printing of this report. Any Reset Use For This Run Only| Apply
changes you make to the
headings will not appear
on other reports. oKk | Cancel |

Canvass Left Edge Heading Line Ma. Canvass Right Edge Heading
NUMBERED KEY CANVAS 1

Enter the text that appears at the top left of your report in the Canvass Left Edge
Heading field.

Enter the line number on which you want this heading to print (1, 2, or 3) in the Line
No. field.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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NOTE: If you choose to print something on line 3, the time/date stamp and the
report number and page will print on the fifth line, instead of the fourth.

7. Enter the text that appears at the top right of your report in the Canvass Right Edge

Heading.

8. Click Reset to clear your settings. Click Use For This Run Only to only use your
headings with the next report that you print. Click Apply to use your headings for all

reports of the same type.
Options Tab

9. Click the Options tab, and
choose the options you want
to include on the report.

Selection | Headings Options | Reporting Group] Print Which Groups]

I Include overfunder reporting?  Percentages: |Cand % based on votes castNoovin % v |

v Include time/date stamp? —
Number of copies: o

[~ Include page number?

[~ Include precincts reported line?

F Precinct terminology |[FRECINCTE

-

™ Always use R/V totals? :l

[ Print contest totals? Print multiple copies in what seq.? |M jrong) -

[™ Print candidates in vote seq.?
I~ Print 1up format?
™ Exclude local contests?

Reset Use For This Run Only Apply |

oK Cancel |

The table below will explain each option and which report the option is active for.

Option Description

Active for

Include over/ | to include over-vote and

under under-vote totals in your report. EL52D Numbered Key—Districts only

reporting?

EL52, Numbered Key Canvass

EL60, Local Office Canvass

EL86, Jurisdiction Canvass

EL111, Name Heading Canvass

EL116, District Totals Canvass

EL119, Canvass—Block Style

EL166, District Totals, Election Day A/V Combined

ES&S
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Option

Description

Active for

Include date/
time stamp

Include the date and time your
report was generated at the top left
of the first page of your report

EL52, Numbered Key Canvass

EL52D Numbered Key—Districts only

EL52S, Statistics Canvass

EL60, Local Office Canvass

EL86, Jurisdiction Canvass

EL111, Name Heading Canvass

EL116, District Totals Canvass

EL166, District Totals, Election Day A/V Combined

Include page
number?

Includes page numbers

EL52, Numbered Key Canvass
EL52D Numbered Key—Districts only
EL52S, Statistics Canvass

EL60, Local Office Canvass

EL86, Jurisdiction Canvass

EL111, Name Heading Canvass

Include
Precincts
reported line

The number of precincts counted
on your report. This will include a
line for each contest and for
example will show, (WITH 3 OF 9
PRECINCTS COUNTED)

EL52, Numbered Key Canvass

EL52D Numbered Key—Districts only

EL52S, Statistics Canvass

EL60, Local Office Canvass

EL86, Jurisdiction Canvass

EL111, Name Heading Canvass

EL116, District Totals Canvass

EL166, District Totals, Election Day A/V Combined

Print totals Displays election totals without EL52S, Statistics Canvass

only (no including precinct detal EL52, Numbered Key Canvass

detail) EL111, Name Heading Canvass

Summarize Combines the absentee numbers EL116, District Totals Canvass

absentee for each of your precincts into a EL166, District Totals, Election Day A/V Combined
precincts? single absentee total.

Use seq. page

Numbers your pages sequentially. If

EL116, District Totals Canvass

numbering? it is not selected, the number of the EL166, District Totals, Election Day A/V Combined
first contest on the page, the last
contest on the page and the page
number within the contest set,
determines your page number.
Separate Organizes your results by party in EL60, Local Office Canvass
Reports by precinct sequence order. When
Party? Separate Reports by Party is not
selected, your results are organized
by precinct in party sequence order
Include only Includes only counted precincts in Not active on any canvass reports
counted the report.
precincts?

Print contest
totals?

Totals line for each contest in the
report.

Not active on any canvass reports

ES&S
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Option

Description

Active for

Print
candidates in
vote

Prints the candidates in vote
sequence, listing candidates in
order of the greatest vote tally first.

Not active on any canvass reports

sequence? If this option is not selected, the
report will print in the same order
that the candidates occur on the
ballot (or in home rotation if
candidates rotate).
Print 1 up If selected will print the report in Not active on any canvass reports
Format? one column format. If it is not
selected it will print the contest in
two columns.
Exluce local Excludes totals for local contests Not active on any canvass reports
contests? from the report
Percentages * Select No Cand% - No OV/UN% | Not active on any canvass reports
- to omit all percentages from
your report.
® Select Cand % Based on Votes
Cast No. ov/uv % - to print the
candidate percentages based
on the number of votes cast in
that contest, not including over
and under votes.
Number of Sets the number of reports that you | Not active on any canvass reports
copies would like to generate.
District The District Control File is located in EL52D Numbered Key—Districts only
control file the \elecdata folder and has a .dst EL52S, Statistics Canvass
name extension. EL116, District Totals Canvass
Refer to the Create a District EL166, District Totals, Election Day A/V Combined
Control File heading in this chapter
for information about how to
create a district control (.dst) file if
ES&S did not create one for you.
Precinct Enter the term in the field used by EL52, Numbered Key Canvass
terminology the jurisdiction to describe EL52D Numbered Key—Districts only

precincts. Example: Wards, Election
Districts.

EL52S, Statistics Canvass

EL60, Local Office Canvass

EL86, Jurisdiction Canvass

EL111, Name Heading Canvass

EL116, District Totals Canvass

EL166, District Totals, Election Day A/V Combined

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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Option

Description

Active for

Prt. Cert

Controls how the certificaiton
message appears on the the
reports.

®* N - Do not place certification
text on your report.

® S - Place certification text on
the same page as your report.

® Y- Place certification text on a
separate page of your report.

EL52, Numbered Key Canvass
EL52D Numbered Key—Districts only
EL52S, Statistics Canvass

EL60, Local Office Canvass

EL86, Jurisdiction Canvass

EL111, Name Heading Canvass

Print multiple
conts on same

pg

Controls how contests appear on
your reports

® B - Display more than one
contest under one legend per
page and use the remaining
space on a page to print the
next contest.

® N - Display each contest on a
separate page.

® P - Use the remaining space on
a page to display the next
contest, if there is room.

® Y - Display more than one
contest under one legend per
page.

EL52, Numbered Key Canvass
EL52D Numbered Key—Districts only
EL52S, Statistics Canvass

Print Multiple | Controls the order in which reports | Not active on any canvass reports.
Copies in are printed
what seq?
9 ® N - Print one copy of the report
® P - Print multiple copies of each
precinct’s results before
printing results for the
® R - Print a copy of the entire
report and then repeat the
process for the next
Include Include write-in candiates on EL119, Canvass—Block Style
write-ins reports

Heading every
page

Print a heading on every page of
the report

EL119, Canvass—Block Style

Include
statistics

Print statistics on the report.

EL119, Canvass—Block Style

ES&S
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Reporting Group Tab

10. On the Reporting Group tab, select the group you want to print.

Select ELECTION Selectionl Headingsl Options Reporting Group | Print Which Groups |
TOTALS to print a

total of all your Current Report Group: _
reporting groups. S Efsc;otr; eDay

Select one of the
other groups you
defined to print a
total of only that

group.

oK Cancel

Refer to Chapter 8: Create ERM from XML Files for information about reporting
. groups and how to create them.

ﬁ NOTE: Print Which Groups is not an option for this report type.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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Output Destination

11. Return to the Selection tab
and select an Output
Destination.

* Click Disk if you want to
view the report on your
PC. You have the option
to print the report after
you view it.

*  Click Printer if you want

Chapter 32: Canvass Report Options 107

Selection lHeadings] Options] Reporting Group | Print Which Groups

to send the report
directly to a printer
without viewing it.

e Click Internet to print the
report in HTML format.

Al
" Contest/Precinct
" File | J
Apply
QOutput Destination
+ Preceded by a statistics canvass
" With statistics printed as contests ;
" Without statistics " Internef
Apply
oK Cancel

12. Click OK. If you selected Printer as the Output Destination, the report will
automatically print. If you selected Disk, the report file will load and will show the

report file that you have selected. Click OK to

load the The Report File Utility window

13. Click OK. The Report File Utility window appears.

14. Click the EL52 Numbered

Key Canvass report.
15. Click the appropriate Report

button to perform one of
the following actions.

Statistics

* Click Display if you
want the report to
appear on your PC for
immediate viewing.

e Click Print to send the

Display

Hunbered Key Canvass

Hame Heading Canvass
District Totals Canvass
Canvas=-Block Style
District Totals Canvass

| Report File Utili

Timestamp

10-25-2011 03:12:03 PH
05-24-2012 05:35:01 P¥
05-24-2012 05:29:02 PH
05-24-2012 05:31:15 P¥
05-24-2012 05:44:13 PY

Canvass

Print Delate Copy Cancel

report to the printer.

* Click Delete to remove
the selected report
from your printer.

* Click Copy to copy the
report to another
location or media.

¢ Select Cancel to return to the main menu.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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Display the Report

When you display a report, the following menu appears at the top left of the report
screen.

°,

< From the Edit menu, click Set Font Size... to change the . —
font size of the report. “ File Edt View Search

After you select the font size you want, click OK to = Font e S e
change the size of the font on the displayed report.

Font size:

m - [ ok |
Cancel

< Click View to move around within the report. Use the
following commands:

* To move to the first page of the report, select First

Page or press CTRL + F. [View] Search
* To move to the last page of the report, select Last First Page  Cirl+F
Page or press CTRL + L. LastPage  Ctr+l
* To move forward one page, select Next Page or NextPage  Ctrl+N

press CTRL + N. Previous Page Ctrl+P

*  To move back one page, select Previous Page or
press CTRL + P.

Goto Page.. Ctrl+G

* To move to a specific page, select Go to page or
press CTRL + G and then enter the page number.

< Click Search and select Find to
locate a particular name or string

of text. The Find window Find what: |
_ Cancel |

appears. Cancel

ﬁ NOTE: The Find option is case sensitive.

Enter the text string and click Find. Press F3 or click Find Next to find the next
instance of that string. The program will then find and highlight it.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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Number Key-Districts Only

ES&S

Take the following steps to generate the Number Key—Districts Only canvass.
Create a District Control File
Generate the Number Key—Districts Only Report

A district control file (xxxxxxxx.dst) must be manually created before you can generate a
Number Key Heading—Districts Only report. The district control file dictates the format of
the Number Key Heading-Districts Only report. The .dst file is usually created by ES&S and
placed in the \elecdata folder. If you need to create this file yourself, take the following
steps.

This file must be in the \elecdata directory on the drive where your election files reside.
When you run the report, you must specify this file (xxxxxxxx.dst) in the District control
file name field on the Options tab of the report.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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Create a District Control File
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Using any text editor that does not compress spaces, such as NOTEPAD, create a file with
a user-defined name and the .dst extension. The first two lines must be exactly as shown
in the following sample. All lines are 72 spaces long and are constructed in the following

manner:

The file should look like the following sample.

REGO000T VOTING PRECINCTS
COUNTY S COUNTY TOTALS
CNGO001 15T CONGRESSTONAL
CNG0002T 2ND CONGRESSIONAL CONGRESSTIONAL TOTAL
SEN0001 15T STATE SENATE
SEN0002 2ND STATE SENATE
SEN0O050T 50TH STATE SENATE SENATE TOTAL
REP0001 1ST STATE HOUSE
REP0002 2ND STATE HOUSE
REP0100T 100TH STATE HOUSE HOUSE TOTAL
MUNBARR BARRINGTON
MUNBRISS BRISTOL BARREBRIS SUBTOTAL
NUMWOONT WOONSOCKET CITY TOTAL
Paosition 1-7 Position 10-32 (Description of District) 33-39 (seven spaces) Postion 40-71 (32 character limit)
(Dist 1D)
Position 8-9
Character Total
Flag
(S=Subtotal,
T=Total) plus 1
or 2 spaces

< A seven character District ID from EDM (positions 1-7)

<+ Either a one character total flag (S=Subtotal; T=Total) plus one space or two spaces
(positions 8-9)

< A 23-character description of the district (positions 10-32)

<+ Seven spaces (positions 33-39) and a 32-character totals description if it is a totals line
(positions 40-71)

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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Generate the Number Key-Districts Only Report

From the Reports menu, point to Canvass, point to Names and District Totals, and click
Standard or Election Day/AV Combined. The Print Election Canvass - Name and District
Totals window appears.

Refer to the Chapter 32: Canvass Report Options for information about setting up
the selection, heading, option and reporting group tabs.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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% | EL52 Page 1 of 4

File Edit View 5earch

EL52, Numbered Key Canvass
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NUMBERED KEY CANUASS
RUN DATE:81,29-13 18:43 AM

REGISTERED UOTERS - TOTAL
BALLOTS CAST — TOTAL
BALLOTS CAST — REPUBLICAN

@081 PRECINCT 1
@82 PRECINCT 2
@AA3 PRECINCT 3
@084 PRECINCT 4

STATISTICS

TOTAL
1,854

PERCENT

BALLOTS CAST — DEMOCRAT
BALLOTS CAST — NONPARTISAN
BALLOTS CAST — BLANK

REPORT-EL52 PAGE BB@1

TOTAL PERCENT
38L 37.47
i88 12.29

a

NUMBERED KEY CANUASS
RUN DATE:01,29-13 18:

UNITED STATES SENATOR
(Uote for no more than >
JACK SHEFHARD
82 JOHN LOCKE
a3 JAMES FORD

AAA1 PRECINCT 1
@BBA2 PRECINCT 2
@@A3 PRECINCT 3
ABA4 PRECINCT 4

UBLICAN

UVOTES

235
139
58

PERCENT

KATE AUSTEN
ROSE HENDERSON
HUGO REYES

REPORT-EL52 PAGE B8@2
VOTES PERCENT
15 .66

75 .38
58 .87
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EL52S, Statistics Canvass

7 | EL525 Page 1 of

File Edit View Search
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REGISTERED UOTERS - TOTAL
BALLOTS CAST - TOTAL
BALLOTS CAST - REPUBLICAN

PRECINCT
PRECINCT
PRECINCT
PRECINCT
PRECINCT
PRECINCT
PRECINCT

8 PRECINCT

aang

PRECINCT

NUMBERED KEY CAMUASS
RUN DATE:81,29-13 18:52 AN

=000 =] O OF s G DD

STATISTICS
TOTAL PERCENT
1,859

819
414

508.55

BALLOTS CAST - DEMOCRAT
BALLOTS CAST - NOMPARTISAN
BALLOTS CAST - BLANK

REPORT-EL52 PAGE B@a1

TOTAL PERCENT
3es 37.24
183 12.21
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EL52D Numbered Key-Districts only

- ’ e LT T

HOUEHBER 4, TeeM B2 EEPORT -ELS2 FACE BeTa
VOTEZ  PERCENT BOTEE  PERCENT
EM FRAMKLIN (2LEM ATLEFT A4
1.788 53
1 E
4414 1.2
1215
5% 1887 14311 471
1508 1927 XI249 1168
A7 18E4 14735 546
b 11 1914 &1 b 6l
1399 1Y 29511 1855 THYY
ANz 1168 1617 (1] 51 1347
1988 AT5Y7 1708 24 4414
417 [T T wy 1] L2 ]
ART [ 1BLTH %Y 32 1183
GBG 4B 484 I 1161
F1 ] E24 TIE M k] (%]
268 ik ARER 166 L3 563
b A 14 1y 54 179 F] ™
1% AL 30 3 (L] 197 2IFT Bl 1y
Fiil 0] 16 (L5 18 i i i 18
T I 5 il 75 1y 2468 1 191
11 147 11 Fi g 11 L1 11 1 T
136 T 187 (1] 148 WY ” 5 136
17 TI47 2 FEe] 1 T 1 ] il
] Ee] AR 114 2159 1 [ 187
57 157 ki 148 (2] 1188 Fed 1 (%]
b 1381 I 151 g7 2851 F ] 2 144
5126 a7 27 187 2050 111 15 245
(] ) 52 ni L] 1WES 54 12 198
] LT 165 17 2574 ama i3 27
1 f1% 18 L35 £ M n 1 52
2 e F ] ATLH 178 14 138
123 SHES s & 1 FETE] Kl 17 FaL]
[ 4958 123 92 197 3 13 [3 243
Mk 1358 67 1696 BT %1 F B57
168 GEAT 126 [ 153 2403 2 F7] 27
13 ke k] 23 138 ¥ ] 1 41
16k 1M 20 1692 EIH] ATHT 158 11 W7
1478 GE2IZ 1361 136 TTT 34563 1868 41 911
L T b BIENA AN L]
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EL111, Name Heading Canvass

5 | EL111 Page 2 of

File Edit View Search
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NAME HEADING CANUASS ANY COUNTY. USA
GENERAL ELECTION
NOUEMBER 5. 2813
RUN DATE:81-29-13 11:85 AM
UNITED STATES SENATOR

{Vote for no more than >

@881 PRECINCT 1
@802 PRECINCT 2
@803 PRECINCT 3
@884 PRECINCT 4

CANDIDATE TOTALS 5
CANDIDATE PERCENT 41 .66

UNOFFICGIAL

REPRESENTATIVE IN CONGRESS. 18TH DISTRICT

{Vote for no more than > 1

@881 PRECINCT 1

@802 PRECINCT 2

@803 PRECINCT 3

@884 PRECINCT 4
CANDIDATE TOTALS
CANDIDATE PERCENT
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EL116, District Totals Canvass
= | EL116 Page 10f 16

File Edit View 5Search

DISTRICT CANUASS
PRINTED B5.-24-12, B84:2%9 PH PAGE P01 .802 .61

UNITED STATES SENATOR REPRESENTATIVE IN
CONGRESS,. 18TH DISTRICT

cCP
H1I
K
E

[=Tes ==l e T En T ey I -]
LESEHED
=SS EDS-
e D=
ZodmoEmT
T = S e 0 e

5 OF ? PRECINCTS

UOTING PRECINCTS 487  38.
TOTALS 487  38.

COUNTY TOTALS 487  38.

=3
b
= =]
aan

=3
b
=
[1a]
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EL166, District Totals, Election Day A/V Combined
115 Pge 1008 P

File Edit View 5earch
| REFUBLICAN -
PRINTED @5/24-12, 84:32 PH PAGE PAZ.@82 .05
REPRESENTATIVE IN COMGRESS, 18TH DISTRICT
CP
RU TP H1
EO UE RE
GT RER I E
I1E BC NC 3
SR ] 0E JLP T
T§ LS UHN JTK EUI 0 ou uu
E LT TT n.I wcege P Uuo NO
R 0 f H R N A H ET DT
E T G E K R E RE EE
PRECINCT DETAIL D 8 E 8 D R 8 RS
PRECINCT 1 651 251 38.56 201 KL 15 A A
PRECINCT 2 201 181  58.2% i (] a A A
PRECINCT 3 201 ti  25.37 161 ta a A A
PRECINCT 4 i 1 198.88 i a a A A
PRECINCT & 5 5 190.808 L a a A A
PRECINCT & A A A a a A A
PRECINCT ? A A A a a A A
PRECINCT 8 A A A a a A A
PRECINCT ¢ A A A (] a A A
UOTING PRECINCTS 1@59 409 38.62 3a9 85 15 A A
ABSENTEES 1@59 A A a a A A
COUNTY TOTALS 1859 409  38.62 389 85 15 A A
; b
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EL119, Canvass—Block Style

. ELY1F

Page

e [d Vew Jearch

GEMERAL ELECT 10N

an

LB - -

et ]
158
S

Sl
.l
A

ETATIETICE

L

L

L
T
13508

FRECIMCT 1
FRECIMCT 2
TOTALE
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[Locar orprce camvass

PRECIHCT

(0001 PRECINCT 1

o0 PRECIHCT 2

(0003 PRECIHCT 3

(0004 PRECINCT 4

DATE:Dd/f16/09 10:29 AM

OFFICE TITLE

ANY COUNTY, Us
GEHERAL ELECTIOM
HOVEMBER 4, 2009

JUSTICE OF THE PEACE PRECINCT 1

JUSTICE OF THE PEACE PRECINCT 2

JUETICE OF THE PEACE PRECINCT 3

JUSTICE OF THE PEACE PRECINCT 4

WITH 4 OF

CAHDIDATE

HOH-JAMES HOWLETT
HOH-PETER BASPUTIN
HOH-KURT WAGHER
OVER VOTES

UNDER WOTES

HOH-ANTHONY STARK
HOH-BRUCE DI, BANHER
OVER VOTES

UNDER ¥OTES

HOH-JOHN COHHOR
HOH-ROBERT DRAKE
OVER VOTES
UNDER YOTES

HOH-LUCAS BISHOP
HOH-FRANK CASTLE
OVER WOTES
UNPER YWOTES

HEFORT-ELGO

FAGE 001

4 PRECINCTS REFORTING

VOTES

330
500
201

1%

Th0

450
47z

1,500
2,500
2
L

43.41
39.46
15.86

1.18

33.50
45.65
.14
-7l

48 .81
51.19

37.43
62.39
0%
12
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EL86, Jurisdiction Canvass

M ELB6 Page 1 of 2

Fle Edt RUENE Search

ISDICTIOHAL CANVASS
RUN DATE:12/02/08 04:33 PH

VOTES PERCENT WOTES
CHARTER AMENDMENT 08-1 FIREMAH TAX CITY OF POHTIAC CHARTER AMENDMENT 08-4 POLICE TAX CITY OF POHTIAC

Vote for not more than 1 Vote for mot more than 1

01 = YES o 07 = YES |

02 = HO L] oG = HO [}

CHARTER AMENDMENT 08-2 BUDGET CITY OF PONTLAC CHARTER AMENDMENT D8&-3 FIRE DEPT MANNING CITY OF FOHTIA(
Vote for not more than 1 Vote for not more than 1

03 = YES o 09 = YES LI

04 = HO L] 10 = HO |

CHARTER AMENDMENT 08-3 ¥0UTH RECREATION CITY OF PONTIAC
Vote for not more than 1

05 = YES o

06 = HO L]

0413 Pontiac City, Pot. 1
0414 Pontiac City, Pot. 2
0415 Pontiac City, Pot. 3
D416 Pontiac City, Pot. 4
0417 Pontiac City, Pot. 5
0418 Pontiac City, Pot. 6
0419 Pontiac City, Pet. 7
0420 Pontiac City, Pot. &
0421 Pontiac City, Pot. 9
0422 Pontiac City, Pot. 10
0423 Pontiac City, Pot. 11
0424 Pontiac City, Pet. 12
0425 Pontiac City, Pet. 13
0426 Pontiac City, Pot. 14
0427 Pontiac City, Pot. 15
0428 Pontiac City, Pot. 16
0429 Pontiac City, Pet. 17
0430 Pomtiac City, Pot. 18

{— T — I — I — O — O — I — I — I — O — I — I — I — A — O — ]
=~ — T — I — N — T — I — O — T — A — I — I — O — Y — T~ ]
(=TT — I — N — I — I O — I — I — I — O ]
{— T — I — I — O — I - - - -]
cooooooeooDeEoLoeocoo oo
(=T~ — O — N — O — I — O — I — I — I — I — O ]
(= — T - — I — - — - I — - - - - - — T - — -]
(=T =N =T = = = = = = = = = == = = = =]
(— T — I T — I — O — I — O — B O -
(=~ — I — I~ I~ — I~ I~ I — I — I — I — I~ — T~ A — Y~ ]
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Precincts Counted/Not Counted

Take the following steps to generate the Precincts Counted/Not Counted canvass.

1. From the Reports menu, point to Canvass, and click Precincts Counted/Not Counted.
The Print Precincts Counted/Not Counted window appears.

Selection Tab

2. Inthe frame in the top

left side of the Selections D
tab, select what you Selection Headings] Options] Reporting Group]
H Groups to include
wa nt to prl nt. " Print counted / not counted - All [T ELECTION TOTALS
o " Print counted - All [ Election Day
¢ SeIECt Prlnt " Print not counted - All [~ Absentee
counted/not  Print counted - Selected

v

" Print not counted - Selected

counted — All to
include information
for all of your

Type of counting to include Output Destination
counted and - ”
R I¥ Packs " Printer
uncounted precincts. ~ Manual =
v Merged Aol
Select Print counted M-
— All to print oK | Cancel

information for all of
your counted
precincts.

Select Print not
counted — All to include report data for all of your uncounted precincts.

Select Print counted — Selected to select specific counted precincts that you want
to generate information for. Select groups and memory types from the available
lists.

Select Print not counted - Selected to include report data your selected
uncounted precincts. Select groups and memory types from the available lists.

NOTE: The options in the Type of counting to include frame and the Groups to
include frame are not available unless you select Print counted — Selected or Print
not counted — Selected.

3. The options in the Type of counting to include frame are automatically selected if you
have selected Print counted - Selected. All types will generally be selected.

ES&S

Contact ES&S before deselecting a type.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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* Central - This option is not available.

*  Packs - Select to include precincts transmitted electronically.

* Manual - Select to include precincts counted manually.

* Merged - Select to include precincts containing merged counts.

If the options in the Groups to include frame are available, select the group(s) you
want to print. Select ELECTION TOTALS to print a total of all your reporting groups.
Select one of the other groups you defined to print a precincts counted/not counted
for only the selected group(s)

Refer to Chapter 8: Create ERM from XML Files for information about reporting
groups and how to create them.

Headings Tab

4. Click the Headings tab

to enter the Selection Headings ]Optionsl Reporting Group
information that you
want to appear on Canvass Center Heading

your report headings. |

5. Enter up to three lines |
of text to appear at the
top center of the

. Canvass Left Edge Heading Line Mo. Canvass Right Edge Heading
report in the Canvass | 1 |
Center Heading area.
You can make any :

Reset | Use For This Run Only| Apply |

necessary changes and
click Apply to save
these changes for each oK | Cancel |

additional printing of

this report. Any

changes to the

headings will not be reflected on other reports.

6. Enter the text that appears at the top left of your report in the Canvass Left Edge
Heading box.

7. Enter the line number on which you want this heading to print (1, 2, or 3) in the Line
No. box.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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NOTE: If you choose to print something on line 3, the time/date stamp and the
report number and page will print on the fifth line, instead of the fourth.

8. Enter the text that appears at the top right of your report in the Canvass Right Edge
Heading.

9. Click Reset to clear your settings. Click Use For This Run Only to only use your
headings with the next report that you print. Click Apply to use your headings for all
reports of the same type.

Options Tab

10. Click the Options tab, and
choose the OptionS you Selection | Headings Options | Reporting Group]
want to include on the o | [ 2

report. I Include page number?
[~ Include precincts reported line?
| - -
P tt | FRECINCTS
« The Include over/under r E——
reporting? field is not = -
available. n 2|
o =l
* SelectInclude date/time ~
stamp? to include the ::

date and time that your
report is generated at Reset Use For This Run Only | Apply |
the top left of the first
page of your report.

oK | Cancel |

* Select Include page
number? to include page numbers on your report.

* Select Include precincts reported line? to include the number of precincts
counted on your report. For example, when results for 42 precincts are tallied in a
jurisdiction of 82 precincts, the message “42 of 82 precincts counted” appears on
the report.

* The Print totals only (no detail) field is not available.

*  The Summarize absentee precincts? field is not available.
* The Use seq. page numbering field is not available.

° The Separate reports by party? field is not available.

* The Include only counted precincts? field is not available.
* The Print contest totals? field is not available.

* The Print candidates in vote seq? field is not available.

* The Print 1 up Format? field is not available.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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* The Exclude local contests? field is not available.

* The Percentages field is not available.

*  The Number of Copies field is not available.

* The District control file name field is not available.

* Enter the term used by your jurisdiction to describe precincts in the Precinct
Terminology box. Some jurisdictions prefer to call their precincts Wards or Polls.

°  The Prt. cert field is not available.
* The Print multiple conts on same pg field is not available.
*  The Print Multiple Copies in what seq? field is not available.

NOTE: The options on the Reporting Group tab are not available for the Precincts
Counted/Not Counted canvass report.

Output Destination

11. Return to the Selection tab.

12. Click an Output Destination.

* Click Disk if you want to view the report on your PC. You have the option to print
the report after you view it.

*  Click Printer if you want to send the report directly to a printer without viewing it.
13. Click OK. If you selected Printer as an S
. . . 7 '| Print Precincts Counted/Not Counted I )
output destination the report will -_—

automatically print. If you selected Disk e e
the Print Precincts Counted/Not Counted
window appears.

Print file is:

ELA0.LST

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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14. Click OK. The
Report File Utility  [[5. Report File Utiity
window appears. Timestam

15. Click the EL50 or
EL50S, Precincts
Counted.

v

10-28-2011 04:50:43 PH
11-01-2011 03:10:13 PH

Display Delete 0| Cancel

NOTE: The EL50 report will print unless you selected Print counted — Selected or
Print not counted — Selected. In that case, the EL50S report will print.

16. Click the appropriate button to perform one of the following actions.

Click Display if you want the report to appear on your PC for immediate viewing.
Click Print to send the report to the printer.

Click Delete to remove the selected report from your printer.

Click Copy to copy the report to another location or media.

Select Cancel to return to the main menu.

Display the Report

When you display a report, the following menu appears at

the top left of the report screen. " File Edit View Search

< From the Edit menu, click Set Font Size... to change the
font size of the report.

ES&S

[Edit | View Search
% Set Font Size...

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
February 13, 2013



After you select the font size you want, click OK to
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change the size of the font on the displayed
report.

< Click View to move around within the report. Use
the following commands:

< Click Search and select Find to locate a particular
name or string of text. The Find window appears.

Enter the text string and click
Find. Press F3 or click Find Next
to find the next instance of that
string. The program will then
find and highlight it.

ES&S

To move to the first page of the report, select
First Page or press CTRL + F.

To move to the last page of the report, select
Last Page or press CTRL + L.

To move forward one page, select Next Page
or press CTRL + N.

Font size:

< ok ]
Cancel

‘u"iew] Search
First Page Ctrl+F

Last Page Ctrl+L

Mext Page Ctrl+M
Previous Page Ctrl+P

Goto Page.. Ctrl+G

To move back one page, select Previous Page or press CTRL + P.

To move to a specific page, select Go to page or press CTRL + G and then enter the

page number.

[Search]
L% Find..

Find Mext F3

Find what: ||

Cancel
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B ELS0 Page 30f 5
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&)X

ELEC

CINCTS COUNTED
DATE : 04 16/09 12:159 FM

TIDH TOTALS

PRECINCT
PRECIHCT
PRECINCT
PRECIHCT
PRECINCT
PFRECINCT
PRECINCT

?

ANY COUHTY, US
GEMERAL ELECTION

HOVEMBER 4, 2009

{HDOT

PRECINCT
PRECIHCT
PFRECIRCT
FRECINCT
PRECTIHCT
FRECINCT

8

COUWHETETD)

9 FPRECINCT
12 PRECINCT
153 FRECINCT
18 FRECINCT
21 PRECINCT
24 PRECINCT

BEFORT-EL5D

¥ _|
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Precincts Completed Listing

Take the following steps to generate the Precincts Completed Listing canvass.

Reports | Suspended

Precinct 2

Election 2
% Canvass 3 MNumber Key Heading
3 Mumber Key-5tatistics Only

Log

MNumber Key-Districts Only

Candidate Name Heading

Mames and District Totals 3
Block Style

Jurisdictional

Local Office

Precincts Counted/Mot Counted
Precincts Completed Listing
Packs Received Listing

Precincts Processed Listing

Eagle Statistics

1. From the Reports menu, point to Canvass, and click Precincts Completed Listing. The
Print Precincts Completed Listing window appears.

Selection Tab

2. Under the Selection tab,
select what you want to  |[&hPrint Precincts Completsd Listin

print. Selection lHeadingS] Options] Reporting Group
Groups to include
-

" Print listing - include groups I
-

Output Destination
™ Disk

&+ Printer

~

Apply

oK |

NOTE: The options under the Groups to include and Type of counting to include
frames are not available for the Print Precincts Completed Listing. All groups are

@ printed regardless of whether you select Print listing or Print listing - include groups.
However, the Print listing - include groups prints each updated precinct broken
down by reporting group.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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Headings Tab

3. Click the Headings

tab to enter the Selection Headings loptignsl Reporting Group
information that you

want to appear on Canvass Center Heading
your report |

headings.

4. Enter up to three
lines of text to

Canvass Left Edge Heading Line No. Canvass Right Edge Heading

appear at the top | [1 |
center of the report
in the Canv

eta a§s Reset Use For This Run Only| Apply |
Center Heading area.
You can make any
necessary changes 0K | Cancel |

and click Apply to
save these changes
for each additional printing of this report. Any changes to the headings will not be
reflected on other reports.

5. Enter the text that appears at the top left of your report in the Canvass Left Edge
Heading box.

6. Enter the line number on which you want this heading to print (1, 2, or 3) in the Line
No. box.

NOTE: If you choose to print something on line 3, the time/date stamp and the
6 report number and page will print on the fifth line, instead of the fourth.

7. Enter the text that appears at the top right of your report in the Canvass Right Edge
Heading.

8. Click Reset to clear your settings. Click Use For This Run Only to only use your
headings with the next report that you print. Click Apply to use your headings for all
reports of the same type.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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Options Tab

9. Click the Options tab, and choose the options you want to include on the report.

The Include
over/under Selection | Headings Options ]Reporting Group]
reporting? field ;l ol rapnde tpary | =
. . Include time/date stamp?
is not available. [ Include page number?
[~ Include precincts reported line? ,7

lect Incl ? i
select i clude > Precinct terminol PRECINCTS
date/time - ogy
stamp? to r [ =
include the date E =]
and time thét - —
your report is =
generated at the m
top left of the =
ﬁrSt page Of Beset Use For This Run Only| Apply |
your report.
Select Include oK | Cancel |

page number?
to include page numbers on your report.

Select Include precincts reported line? to include the number of precincts
counted on your report. For example, when results for 42 precincts are tallied in a
jurisdiction of 82 precincts, the message “42 of 82 precincts counted” appears on
the report.

The Print totals only (no detail) field is not available.

The Summarize absentee precincts? field is not available.
The Use seq. page numbering field is not available.

The Separate reports by party? field is not available.

The Include only counted precincts? field is not available.
The Print contest totals? field is not available.

The Print candidates in vote seq? field is not available.
The Print 1 up Format? field is not available.

The Exclude local contests? field is not available.

The Percentages field is not available.

The Number of Copies field is not available.

The District control file name field is not available.

Enter the term used by your jurisdiction to describe precincts in the Precinct
Terminology box. Some jurisdictions prefer to call their precincts Wards or Polls.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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e The Prt. cert field is not available.
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*  The Print multiple conts on same pg field is not available.

* The Print Multiple Copies in what seq? field is not available.

Completed Listings report.

Output Destination

10. Return to the Selection

11.

12.

tab.

Click an Output ¥ 4
Destination.

* Click Disk if you want
to view the report on
your PC. You have
the option to print
the report after you
view it.

*  Click Printer if you
want to send the

 Print listi n;— include groups o

NOTE: The options on the Reporting Group tab are not available for the Precincts

7 '| Print Precincts Completed Listing

Selection lHeadings] Options] Reporting Group

Groups to include
-

-

Qutput Destination
" Disk

" Printer

~

Apply

report directly to a
printer without
viewing it.

Click OK. If you selected Printer as an
output destination the report will
automatically print. If you selected Disk,
the Print Precincts Completed Listing
window appears.

Cancel

OK |

® | Print Precincts

Listing is complete!

Print file is:

EL50ALST
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13. Click OK. The
Report File Utility

Timestamp

window appears. Elestion Summary 10282011 04:50:43 PH
Precincts Counted 11-01-2011 03:10:13 PH
Precincts Completed Listing 11-01-2011 03:51:16 PH

14. Click the EL50A,
Precincts
Completed Listing.

15. Click the
appropriate button
to perform one of
the following
actions.

Display Delete 0| Cancel

* Click Display if you want the report to appear on your PC for immediate viewing.
e Click Print to send the report to the printer.

* Click Delete to remove the selected report from your printer.

e Click Copy to copy the report to another location or media.

¢ Select Cancel to return to the main menu.
Display the Report

When you display a report, the following menu appears at _ R
the top left of the report screen. " File Edit View Search

< From the Edit menu, click Set Font Size... to change the

font size of the report. [Edit] View Search

L} Set Font Size..,

After you select the font size you want, click OK to
change the size of the font on the displayed
report.

Font size:

<] ok ]
Cancel

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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Click View to move around within the report. Use

the following commands: View | Search

First Page Ctrl+F

* To move to the first page of the report, select

First Page or press CTRL + F. et ErE EOEL

* To move to the last page of the report, select MNext Page  Ctrl+N
Last Page or press CTRL + L. Previous Page Ctrl+P
* To move forward one page, select Next Page GotoPage.. Ctrl+G

or press CTRL + N.
* To move back one page, select Previous Page or press CTRL + P.

* To move to a specific page, select Go to page or press CTRL + G and then enter the
page number.

Click Search and select Find to locate a particular
name or string of text. The Find window appears.

[Search]
L% Find..

Find Mext F3

Enter the text string and click
Find. Press F3 or click Find Next
to find the next instance of that
string. The program will then
find and highlight it.

Find what: ||

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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EL50A, Precincts Completed Listing

PEECINCTS COMPLETED LISTING
REPORT-EL50A

RUH DATE: 0471609 04:16 PH {WITH 6 OF 25 PRECINCTE REPU

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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Print Precinct Processed Listing

Selection Tab

1. On the Selection tab, choose
the contests and/or
precincts that you want to
appear on your report.

* Select All to print all
contests and precincts

¢ Select Contest/Precinct
to generate a report for
specific contests or
precincts. Take the
following steps to select
specific contests or
precincts.

a. Type a contest
sequence number in
the Contest field or
click Contests to
open the Contest
window

b. Select from the
list of available
contests. To select
several contests,
press and hold the
Ctrl key while
clicking the contests
you want to select.
There is a limit of 71
contests on this
screen.

ES&S

Chapter 32: Canvass Report Options

Selection l Headings ] Opﬂons] Reporting Group | Print Which Groups

Al

" Contest/Precinct

" File | J
Apply
Output Destination
o " Disk
~
» " Internet
Apply

135

Cancel

0001 REGISTERED VOTERS - TOTAL

0002 BALLOTS CAST - TOTAL

0003 BALLOTS CAST - NONPARTISAN
0004 BALLOTS CAST - DEMOCRATIC
0005 BALLOTS CAST - BLANK

0101 UNITED STATES SENATOR

0102 UNITED STATES CONGRESS, DISTRICT 2
0103 GOVERNOR

0104 SECRETARY OF STATE

0105 STATE TREASURER

0106 SECRETARY OF STATE

0107 ATTORNEY GENERAL
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c. Type a precinct
identification
number in the
Precinct field or click
Precincts to open

0001 PRECINCT 1

the Precincts 0002 BRECINGT 2
window. 0003 PRECINGT 3
0004 PRECINCT 4
0005 PRECINCT 5
0006 PRECINCT 6
list of available 0008 PRECINCT &
B 0009 PRECINCT 9
precincts. To select
several precincts,
press and hold Ctrl
while clicking the
precincts you want
to select. There is a
limit of 71 precincts

on this screen.

Cancel I

* Select File to generate a report from an existing election file that you have
created. Select an available file from the list or create a new file.

Headings Tab

5. Click the Headings tab
to enter the
information that you Canvass Center Heading
want to appear on your ||
report headings. |

Selection Headings lOptions] Reporting Group | Print Which Groups

6. Enter up to three lines
Of identiﬁcation text Canvass Left Edge Heading Line MNo. Canvass Right Edge Heading
that you want to SUMMARY REPORT 1
appear at the top
center of your reportin

Reset Use For This Run Onl Appl
the Canvass Center £ese Use For This Run Only| Apply
Heading fields.

7. Enter the text that oK Cancel

appears at the top left
of your report in the Canvass Left Edge Heading field.

8. Enter the line number on which you want this heading to print (1, 2, or 3) in the Line
No. field.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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@ NOTE: If you choose to print something on line 3, the time/date stamp and the

report number and page will print on the fifth line, instead of the fourth.

9. Enter the text that appears at the top right of your report in the Canvass Right Edge
Heading.

10. Click Reset to clear your settings. Click Use For This Run Only to only use your
headings with the next report that you print. Click Apply to use your headings for all
reports of the same type.

Options Tab
11. Click the Options tab, and

ES&S

i = | Print Precinct Proceszed Listing
choose the options you Ml

want to include on the Selection] Headings Options lReporting Group] Print Which Groups]

report. = | =
[ Include time/date stamp? ,7
[ Include page number?
r [
r ,7
F
r [ =
F
F
r [ =
F
F
F

Reset Use Far This Run Only Apply

* Include over/under reporting? field not available.

* Include time/date stamp? to include the date and time that your report is
generated at the top left of the first page of your report.

* Include page number? to include page numbers on your report.
* Include precincts report line? field is not available.

* Print totals only (no detail)? field is not available.

° Summarize absentee precincts? field is not available.

* Use seq. page numbering field is not available.

° Separate reports by party? field is not available.

* Include only counted precincts? field not available.

*  Print totals only (no detail)? field not available

° Summarize absentee precincts? filed not available
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* Use seq. page numbering? field not available

° Separate reports by party? field not available

¢ Select Print contest totals? field not available.

* The Print candidates in vote seq? field is not available.

e Select Print 1 up Format? field not available

¢ The Exclude local contests? field is not available.

* Percentages: Select No Cand% - field not available

*  Number of Copies field not available.

¢ District control file name field is not available.

* Precinct terminology field is not available.

e Prt. Cert field not available.

*  Print Multiple Copies in What Seq.: field not available

Reporting Group Tab

ES&S

12. On the Reporting Group tab,
select the group you want to
print.

Select ELECTION TOTALS to
print a report for all your
reporting groups. Select one of
the other groups you defined
to print a total of only that

group.

Selection Headmgs] Options Reporting Group l Print Which Groups]

Defined G
Current Report Group: s b e
ELECTIDN TOTALS
Election Day
ELECTION TOTALS Absentee
oK Cancel
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Output Destination

13. Return to the Selection

tab’ and select an Output Selection lHeadings] Optiuns] Reporting Group | Print Which Groups
Destination. & Al
" Contest/Precinct
* Click Disk if you want ! [oane |
to view the report on | __ Bresincts |
your PC. You have the CiFile | | -]
option to print the Apply
report after you view Qutput Destination
it. .
-

e Click Printer if you
want to send the
report directly to a
printer without
viewing it.

oK Cancel

* Click Internet to print
the report in HTML format.

14. f you selected Printer as an Output Destination, the report will automatically print
when you click OK.

15. If you selected Disk, the report file will load

: :
and will show the report file that you have P17 oS
selected. Click OK to load the The Report File Listing is completa!
Utility window. Print file is:

EL45.LST

16. Select your report from
the Report File Utility.

Report Timestamp

17. Click the appropriate
button to perform one
of the following actions.

ELS0D  Precinct Pr s =tinc 01-24-2013 01:04:33 FM

* Click Display if you
want the report to
appear on your PC
for immediate
viewing.

° CIle Print to Send Display Print Delete Copy Cancel
—
the report to the

printer.
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NOTE: The Print option only works with a printer connected to the PC through the
@ LPT1 port. If you are using a USB printer, click Copy and save the report as a .txt file.
Then, open the .txt file and print it.

* Click Delete to delete the selected report.
* Click Copy to copy the report to another location or media.

¢ Select Cancel to return to the main menu.
Display the Report

When you display a report, the following menu appears at
the top left of the report screen. " File Edit View Search

< The File menu you can select Exit to exit out of the Report File
Utility Screen.

File | Edit View
h Exit

Edit | View Search
L} Set Font Size..,

< From the Edit menu, click Set Font Size... to change the
font size of the report.

Click on the drop down menu to select the font size.
After you select the font size you want, click OK to change
the font size report that you currenlty have displayed.

Font size:

W -] o< |
Cancel

< Click View to move around within the report. Use the
following commands:

* To move to the first page of the report, select First View | Search
Page or press CTRL + F. First Page Ctrl+F
* To move to the last page of the report, select Last LastPage  Ctri+L
Page or press CTRL + L. Mext Page  Ctrl+N
* To move forward one page, select Next Page or Previous Page Ctrl+P

press CTRL + N. Goto Page.. Cirl+G

* To move back one page, select Previous Page or
press CTRL + P.

* To move to a specific page, select Go to page or
press CTRL + G and then enter the page number.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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< Click Search and select Find to locate a particular

name or string of text. The Find window appears. [ Search |

Find...
Find Mext F3

Enter the text string and click Find. Press
F3 or click Find Next to find the next
instance of that string. The program will
then find and highlight it

Find what: ||

Cancel |

@ NOTE: The Find option is case sensitive.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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EL50D Precinct Processed Listing

& | ELS0D Page 1 of 27

File Edit View Search
PRECINCTS PROCESSED LISTING Any County, USA UNOFFICIAL -
General Election ¥
November 5, 2813
RUN DATE:81-24-13 B81:84 FM
Precinct GROUP SERIAL NO. BALS SERIAL NO. BALS SERIAL MO. BALS SERIAL NO. BALS
1 PRECINCT 1 — 8 1 a7378864 ?
1 PRECINCT 1 — 8 2 a7378864 ?
2 PRECINCT 1 - 1 1 a7378864 a
2 PRECINCT 1 - 1 2 a7378864 ?
3 PRECINCT 2 2 a7378864 ? 2
4 PRECINCT 3 2 a7378864 a
5 PRECINCT 4 2 a7378864 a
6 PRECINCT 5 — 8 2 a7378864 a
? PRECINCT 5 - 1 2 a7378864 a
8 PRECINCT 6 2 a7378864 a
2 PRECINCT 7?7 2 a7378864 a
18 PRECINCT 8 2 a7378864 a B
11 PRECINCT 9 2 a7378864 a
12 PRECINCT 18 2 a7378864 a
13 PRECINCT 11 2 a7378864 a
14 PRECINCT 12 2 a7378864 a
15 PRECINCT 13 2 a7378864 a
16 PRECINCT 14 2 a7378864 a
17 PRECINCT 15 2 a7378864 a i
4 [ | P_J
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DS200 Precincts Processed Listing

Each time voting results are imported into ERM from a DS200 USB flash drive, ERM
captures the machine ID of each DS200. The DS200 Precincts Processed Listing is an audit
report for the DS200 IDs collected and updated.

Jurisdictions can use this report to compare DS200 Precincts Processed Listing with a
known list of IDs deployed to each precinct. A county election official can use this list to
determine if results have been imported from all DS200 scanners.

The DS200 Precincts Processed Listing lists up to ten machine IDs per precinct per ERM
group.

Take the following steps to generate the DS200 Precincts Processed Listing report.

Suspended
Precinct 3
Election 4
L\) Canvass » Nurmber Key Heading
Leg 4 Number Key-Statistics Only

Number Key-Districts Only

Candidate Name Heading
MNames and District Totals 3

Block Style

Jurisdictional

Local Office

Precincts Counted/Not Counted
Precincts Completed Listing
Packs Received Listing

Precincts Processed Listing

Eagle Statistics

1. From the Reports menu, point to Canvass, and click DS200 Precincts Processed
Listing. The Print DS200 Precincts Processed Listing window appears.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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Headings Tab

2. Click the Headings tab to
enter the information
that you want to appear
on YOUF report headings- Canvass Center Heading

Selection Headings lOptinns] Reporting Group

3. Enteruptothree lines of |
text to appear at the top |
center of the report in
the Canvass Center Canvass Left Edge Heading Line No. Canvass Right Edge Heading
Heading area. If you | 1 |
entered text in HPM
HeadingS and Reset Use For This Run Only| Apply |
Certification the heading
area will already be
completed. You can ok | Cancel |
make any necessary
changes and click Apply to save these changes for each additional printing of this
report. Any changes to the headings will not be reflected on other reports.

4. Enter the text that appears at the top left of your report in the Canvass Left Edge
Heading box.

5. Enter the line number on which you want this heading to print (1, 2, or 3) in the Line
No. box.

NOTE: If you choose to print something on line 3, the time/date stamp and the
@ report number and page will print on the fifth line, instead of the fourth.

6. Enter the text that appears at the top right of your report in the Canvass Right Edge
Heading.

7. Click Reset to clear your settings. Click Use For This Run Only to only use your
headings with the next report that you print. Click Apply to use your headings for all
reports of the same type.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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Options Tab

8. Click the Options tab,
and choose the options
to include on the report.

* Select Include date/
time stamp? to
include the date and
time that your report
is generated at the
top left of the first
page of your report.

e Select Include page
number? to include
page numbers on
your report.

Reporting Group
Tab

9. On the Reporting
Group tab, select the
group you want to
print.

Select ELECTION TOTALS to
print a total of all your
election groups. Select one
of the other groups you
defined to print a total of
only that group.
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Selectionl Headings Options | Reporting Groupl Print Which Groupsl

B [ricliiel= ool = reaonting @ | Farzamzs: | -
¥ Include time/date stamp?

I Include page number?

| Frinie otk il i ]2zl
B =iz 2santas i
B Uiz sz wizin) il ? Fri et =l g ==z o) | vl

& i 85 e |z - -
| etz reports by pa Y_ Frint muliiala cants an samea gy | vl
U i el = il ez ez

| il = st reae i ins? Bijziret soniro] il rEzims: I

W Briii moptzst i)

B Pririe ezinelielziezs i e 2z 2

| i e e

W =iicluilz [gies)| conizsi=?

Reset

L

(e RN E S

Fracinet izl

T BN EEN e (S E T | vl

Use For This Run Only Apply

0K Cancel

Selection | Headings | Options Reporting Group |Print Which Gmupsl

Current Report Group: roshes Sroups
ELECTION TOTALS
Election Day
ELECTION TOTALS Absentee
DK Cancel
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Output Destination

10. Return to the Selection Selection lHeadings] Options] Reporting Group | Print Which Groups

tab.
Al
" Contest/Precinct
11. Click an Output
an Sutp |
Destination.
|
want to view the ot
bC Apply
report onyour O Output Destination
You have the option ~ s
to print the report » & Printer
after you view it. £ L
Appl

e Click Printer if you — sty |
want to send the
report directly to a o S
printer without = =
viewing it.

12. Click OK. If you selected Printer as an O AT

output destination the report will
automatically print. If you selected Disk,
the Print DS200 Precincts Processed CLeoD LS T

Listing window appears. ox

13. C!ick OK Thg Report T e .
File Utility window D

Listing is complete!

Print file is:

Report Timestamp

appears' EL45 Election Summary 10282011 04:50:43 PH
ELS0 Precincts Counted 11012011 03:10:13 PM
ELS0A FPrecincts Completed Listing 11-01-2011 03:51:16 PH

Precincts Processed Listing 11-01-2011 04:10:03 PH

14. Click the EL50D,
DS200 Precincts
Processed Listing.

15. Click the appropriate
button to perform
one of the following
actions.

Display Print Delete Copy Cancel

* Click Display if
you want the report to appear on your PC for immediate viewing.

*  Click Print to send the report to the printer.
* Click Delete to remove the selected report from your printer.
* Click Copy to copy the report to another location or media.

e Select Cancel to return to the main menu.
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Display the Report
When you display a report, the following menu appears at
the top left of the report screen. " File Edit View Search

< From the Edit menu, click Set Font Size... to change the

[Edit | View Search

font size of the report.
L} Set Font Size...

After you select the font size you want, click OK to
change the size of the font on the displayed
report.

Font size:

< Cox |
Cancel

< Click View to move around within the report. Use

the following commands: View | Search

First Page Ctrl+F
Last Page Ctrl+L

* To move to the first page of the report, select
First Page or press CTRL + F.

* To move to the last page of the report, select Mext Page  Ctrl+N
Last Page or press CTRL + L. Previous Page Ctrl+P
* To move forward one page, select Next Page GotoPage.. Ctrl+G

or press CTRL + N.

* To move back one page, select Previous Page or press CTRL + P.

* To move to a specific page, select Go to page or press CTRL + G and then enter the

page number.

< Click Search and select Find to locate a particular

name or string of text. The Find window appears. [ Search |

L% Find..

Find Mext F3

Enter the text string and click
Find. Press F3 or click Find Next
to find the next instance of that
string. The program will then

Find what: ||

find and highlight it.
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EL50D, DS200 Precincts Processed Listing

B ELS0D Pape 1 of 1

Test RIGHT SIDE
REPORT-ELS8D  PAGE @Al
PRECINCT GROUP  SERIAL WO. BALS SERIAL MO. BALS SERIAL MO. BALS SERIAL MO, BALS SERIAL HO. BALS
22 JEFFERSONUILLE 11 2 By42Im 28 @7423082 21 A7423003 22 B7423884 23 BP4ZIBAS 24
BP4Z TEG 25 @P4zIeE? 26 #7427 3088 27 B74Z3009 ZH  @P4ZTe1e 29
23 JEFFERSONUILLE 11 2 B74238E I8 87423082 31 @7423883 32 @7423084 331 BY4ZI0ES 34
BP4Z 3806 35 @74ZI087 36 A7423088 37 87423089 3 Bv4zI0L8 39
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Chapter 33: Log

Generate log reports to check the status of your election equipment and software. Refer
to your log reports if any errors occur during the vote counting process.

System Log: Generate a System Log report to list every action performed in your election
system in chronological order.

Results Corrections Log: Generate the Results Corrections Log to view user altered
election totals. The Results Corrections Log lists your candidate names, any user altered
totals, the date and time that election totals were altered and the original totals for each
user altered contest.

Real Time Log: This report is not available in this version of ERM.

650 Network Server Log: This option is no longer supported.

System Log

ES&S

ERM maintains one audit file that records log records for activities performed within the
application. The creation of this audit file cannot be disabled by the ERM application.

@ NOTE: The System Log is not erased when the results database is reset or recreated.

There are three ways to view the contents of this audit file.

< Print the ERM System Log using the steps described under this heading.

< Print the ERM System Log directly to a printer in batch mode so that you can view the
physical report.

< Print the ERM System Log in “real time” to a dedicated printer using the steps
described under the Real Time Log heading in this chapter.

r 3 Warning: If you use the Real Time Log, a dedicated line or dot matrix printer is
A required. You must terminate printing the Real Time Log to print the System
k J Log.

Take the following steps to generate the System Log.
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Repeorts | Suspended

Precinct 4
Election 3
Canvass 3
N Log 4 System Log

Results Caorrections Log

Real Time Log

650 Network Server Log

1. From the Reports menu,
point to Log, and click
System Log. The Print

System Log Listing window
appears.
. [ Brecincts... |

Selection Tab
2. Under the Selection tab, f —

Select What you want to " Print counted in chronological seq. & Printer

. " Print counted in precinct seq. o
print.
* Select Print the entire

log to generate your
entire system log in
chronological order.

* Select Print counted in chronological seq. to print chronological log for your
counted precincts.

* Select Print counted in precinct seq. to print a chronological log by precinct for
your counted precincts.

ELECTION REPORTING MANAGER USER GUIDE v. 8.6
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Headings Tab

3. Click the Headings tab
to enter the

information that you Selection Headings ]Options] Reporting Group | Print Which Gruups]
want to appear on

your report headings. Canvass Center Heading

4. Enter up to three lines
of text to appear at the
top center of the
report in the Canvass

Canvass Left Edge Heading Line Mo. Canvass Right Edge Heading
Center Heading area. SYSTEM LOG LISTING 1
You can make any
necessary changes and
click Apply to save Use For This Run Only|

these changes for each
additional printing of

this report. Any = R
changes to the )
headings will not be
reflected on other reports.

5. Enter the text that appears at the top left of your report in the Canvass Left Edge
Heading box.

6. Enter the line number on which you want this heading to print (1, 2, or 3) in the Line
No. box.

NOTE: If you choose to print something on line 3, the time/date stamp and the
@ report number and page will print on the fifth line, instead of the fourth.

7. Enter the text that appears at the top right of your report in the Canvass Right Edge
Heading.

8. Click Reset to clear your settings. Click Use For This Run Only to only use your
headings with the next report that you print. Click Apply to use your headings for all
reports of the same type.
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Options Tab

9. Click the Options tab, and choose the options you want to include on the report.

e The Include over/ Selectionl Headings Options lReporting Grnupl Print Which Groupsl
ing?
]l:n:je.r reptortmg. - | =
l1eld 1s no v Include time/date stamp? ’7
available. ™ Include page number?
r [
e Select Include r I
. 2 [
daFe/tlme stamp? = —
to include the date -
and time that your r -
report is generated F -]
at the top left of =
the first page of m
your report' Reset Use For This Run Only Apply |
e Select Include
page number? to
include page - —
numbers on your
report.

* The Include precincts reported line? field is not available.
* The Print totals only (no detail) field is not available.

*  The Summarize absentee precincts? field is not available.
* The Use seq. page numbering field is not available.

° The Separate reports by party? field is not available.

* The Include only counted precincts? field is not available.
* The Print contest totals? field is not available.

* The Print candidates in vote seq? field is not available.

* The Print 1 up Format? field is not available.

* The Exclude local contests? field is not available.

* The Percentages field is not available.

*  The Number of Copies field is not available.

* The District control file name field is not available.

* The Precinct terminology field is not available.

* The Prt. cert field is not available.

* The Print multiple conts on same pg field is not available.

* The Print Multiple Copies in what seq? field is not available.
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Reporting Group Tab

v

Output Destination

report.

10. Return to the Selection tab.

11. Click an Output Destination.

* Click Disk if you want to
view the report on your
PC. You have the option

Chapter 33: Log 153

NOTE: The options on the Reporting Group tab do not apply to the System Log

to print the report after !

you view it. |

L Brecincts... |

*  Click Printer if you want
to send the report
directly to a printer
without viewing it.

" Print counted in chronological seq.
" Print counted in precinct seq. o

[ [ T

Output Destination
" Disk
" Printer

Apply

12. Click OK. If you selected
Printer as an output destination the report
will automatically print. If you selected
Disk, the Print System Log Listing window
appears.

13. Click OK. The Report File Utility window
appears.

Listing is complete!

Print file is:

ELGBA.LST
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Chapter 33: Log

Timestamp

System Log. Repon
15. Clickthe appropriate EIS0  Frociacie tmmetly
ELS04 Frecincts Completed Listing
button to perform Procinctc Procececd Ticuing
one of the following
actions.

* Click Display if
you want the
report to appear

on your PC for Display Print Delete

10-28-2011 04:50:43 PH
11-.01-2011 03:10:13 PH
11-01-2011 03:51:16 FH
11-01-2011 04:10:03 FH
11-01-2011 D4:16:02 FPH

Copy Cancel

154

immediate
viewing.

*  Click Print to send the report to the printer.

* Click Delete to remove the selected report from your printer.

* Click Copy to copy the report to another location or media.

¢ Select Cancel to return to the main menu.
Display the Report

When you display a report, the following menu appears at
the top left of the report screen.

< From the Edit menu, click Set Font Size... to change the
font size of the report.

After you select the font size you want, click OK to
change the size of the font on the displayed
report.

|| File Edit View Search

[ Edit | View Search

L\x’ Set Font Size...

Font size:

<] ok ]
Cancel
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°,
£ X4

Click View to move around within the report. Use
the following commands:

Click Search and select Find to locate a particular
name or string of text. The Find window appears.

Enter the text string and click
Find. Press F3 or click Find Next
to find the next instance of that
string. The program will then
find and highlight it.

To move to the first page of the report, select
First Page or press CTRL + F.

To move to the last page of the report, select
Last Page or press CTRL + L.

To move forward one page, select Next Page
or press CTRL + N.
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‘u"ian.r] Search
First Page Ctrl+F

Last Page Ctrl+L

Mext Page Ctrl+M
Previous Page Ctrl+P

Goto Page..  Ctrl+G

To move back one page, select Previous Page or press CTRL + P.

To move to a specific page, select Go to page or press CTRL + G and then enter the

page number.

[Search]
L% Find..

Find Mext F3

Find what: ||
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EL68A, System Log

M [L6BA Page 1 0f 1

Chapter 33: Log 156

Fle Edt view Search

SYSTEM LOG LISTING
DATE:08/21/09 01:%5 PH

SER DATE

04-30
04-30
n4=30

04-30
04-30

04-30
04=30
04-30
04-07

04-07

04-07
04-07
04-07
o4-10
04-10
04-10

04-10
04-10
04-10
04-10
D4=14
na-14
04=14
04-13
04-13
04-13
04-13

TIME

02: 355
02:33
02:56

02:56
02:57

02:37
02:37
02:57
02:35

02:33

0233
02:35
0D2:33
01:5&
01:%6
01:3%6

01:56
01;:56
01:56
01:57
11:06
11:06
11:06
12:37
12:27
12:37
12:37

FITTHONTITTIT FUTINE ¥ WUEY N NN

SYSTEM ACTION OR ERROR INFORMATION COUNTED INFORMATION

DATABASE CREATED
EXITED ELECTION REPORTING MAMAGCER SYSTEM
ENTERED ELECTION REFORTING MAMAGER SYSTEM - REL 6.4.0.0y

START PACE ACCUMULATION (Replace Mode - beginning with first)
STOF PACK ACCUMULATION

START PACE ACCUMULATION (Replace Mode - beginning with firsth
STOF PACE ACCUMULATION

EXITED ELECTION REPORTING MAMAGER SYSTEM

ENTERED ELECTION REPORTING MAMAGER SYSTEM - REL 7.5.2.0¢

CREATED .RSH FILE

CREATEDR .CTH FILE

CONTINUE WITH CURRENT ELECTION - O TOTAL BALLOTS CAST
EXITED ELECTION REPORTING MAMAGER SYSTEM

ENTERED ELECTION REPORTING MAMAGER SYSTEM - REL 7.5.2.0¢
CONTINUE WITH CURRENT ELECTION - 0 TOTAL BALLOTS CAST
ENTERED ELECTION REPORTING MANAGCER SYSTEM - REL 7.5.2.0¢

CREATED .CTH FILE

CONTINUE WITH CURRENT ELECTION - O TOTAL BALLOTS CAST
DATABASE RESET

EXITED ELECTION REPORTING MAMAGER SYSTEM

ENTERED ELECTION REPORTING MANAGER SYSTEM - REL 7.5.2.0¢
CONTINUE WITH CURRENT ELECTION - 0 TOTAL BALLOTS CAST
EXITED ELECTION REPORTING MAMAGER SYSTEM

ENTERED ELECTION REPORTING MAMAGER SYSTEM - REL 7.5.2.0c
HESET RESULTS INMITIATED BY START UP

DATABASE RESET

RESET RESULTS INITIATED BY START UP COMPLETED

JA
ELECTION ID:
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Results Corrections Log

Take the following steps to generate the Results Corrections Log.

I Reports | Suspended

Precinct

Election

Canvass

[\.- Log

r ¥ v v

System Log

Results Corrections Log
Real Time Log

650 Metwork Server Log

1. From the Reports
menu, point to Log,
and click Results

Selection |Headings | Options | Reporting Groupl Print Which Groups |

Correction Log. The @

Print Results ¥ NCUE it

Correction Report CRFEET, | Contests..._|
window appears. Frainzis: | Precincts... |

R I

Apply |

@ Nz i s izt sanEin T
@ i siziisiies arniz 2z conizgis
@ 2z

Cancel
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Headings Tab

2. Click the Headings tab to
enter the information
that you want to appear Selection Headings lOptions] Reporting Group | Print Which Groups]

on your report headings.
Canvass Center Heading

3. Enter up to three lines of
text to appear at the top
center of the report in
the Canvass Center
Heading area. You can Canvass Left Edge Heading Line No. Canvass Right Edge Heading
make any necessary MANUAL CHANGES LOG LI 1
changes and click Apply
to save these changes
for each additional
printing of this report.
Any changes to the
headings will not be
reflected on other
reports.

Use For This Run Only|

Cancel

4. Enter the text that appears at the top left of your report in the Canvass Left Edge
Heading box.

5. Enter the line number on which you want this heading to print (1, 2, or 3) in the Line
No. box.

NOTE: If you choose to print something on line 3, the time/date stamp and the
@ report number and page will print on the fifth line, instead of the fourth.

6. Enter the text that appears at the top right of your report in the Canvass Right Edge
Heading.

7. Click Reset to clear your settings. Click Use For This Run Only to only use your
headings with the next report that you print. Click Apply to use your headings for all
reports of the same type.
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Options Tab

8. Click the Options tab, T e

and choose the options

Selection] Headings Options lReponing Group] Print Which Groups]

you want to include on
the report' l’; Include time/date stam | liJ
p?
™ Include page number?
© The Include Over/ ™ Include precincts reported line?
under reporting? F Precinct terminology [FRECINCTE
field is not available. ul
-
[ [=]
-
. S'elect Include date/ - —
time stamp? to B
. r
include the date and =
time that your Reset Use For This Run Only Apply |
report is generated
at the top left of the
oK Cancel |

first page of your
report.

Select Include page
number? to include
page numbers on
your report.

Select Include precincts reported line? to include the number of precincts
counted on your report. For example, when results for 42 precincts are tallied in a
jurisdiction of 82 precincts, the message “42 of 82 precincts counted” appears on
the report.

The Print totals only (no detail) field is not available.

The Summarize absentee precincts? field is not available.
The Use seq. page numbering field is not available.

The Separate reports by party? field is not available.

The Include only counted precincts? field is not available.
The Print contest totals? field is not available.

The Print candidates in vote seq? field is not available.
The Print 1 up Format? field is not available.

The Exclude local contests? field is not available.

The Percentages field is not available.

The Number of Copies field is not available.

The District control file name field is not available.

Enter the term used by your jurisdiction to describe precincts in the Precinct
Terminology box. Some jurisdictions prefer to call their precincts Wards or Polls.
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*  The Prt. cert field is not available.
*  The Print multiple conts on same pg field is not available.

* The Print Multiple Copies in what seq? field is not available.

Reporting Group Tab

On the Reporting Group tab, select the group you want to print.

election | Headings ions Reporting Grou i oD
Select ELECTION TOTALS to print | Headings | ptions Reporting Group | Print Which Groups |

a total of all your election : Defined Groups

e
groups. Select one of the other Eloction Day
groups you defined to print a RO Absentee

total of only that group.

oK Cancel

ﬁ Refer to Chapter 8: Create ERM from XML Files for information about election
s groups and how to create them.
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Output Destination

10.

11.

12.

13.

14.

Return to the Selection

tab = | Print Results Comrection

Click an Output
Destination.

* Click Disk if you want
to view the report on
P Lo |
your PC. You have
the option to print —
QOutput Destination
the report after you  Disk
view it. '

e Click Printer if you
want to send the
report directly to a
printer without o] Cancel
viewing it.

Click OK. If you selected Printer as an

output destination the report will # | Print Results Correction Repor

automatically print. If you selected Disk,

the Print Results Correction Report

window appears. Print file is-
EL68.LST

Listing is complete!

Click OK._The T Repor ik Uiy
Report File
.rs . Ti tal
Utility window el
Election Sumnary 10-28-2011
appears. Precincts Counted 11-01-2011

Precincts Completed Listing 11-01-2011
Precincts Processed Listing 11-01-2011
Manual Entry Report 11-01-2011 04:26:E50
Sy=tem Log 11-01-2011

Click the EL6S,
Manual Entry
Report.

Click the
appropriate
button to
perform one of
the following
actions.

Display Delete 0| Cancel

* Click Display if you want the report to appear on your PC for immediate viewing.

*  Click Print to send the report to the printer.
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* Click Delete to remove the selected report from your printer.
* Click Copy to copy the report to another location or media.

¢ Select Cancel to return to the main menu.

Display the Report

When you display a report, the following menu appears at
the top left of the report screen.

162

|| File Edit View Search

From the Edit menu, click Set Font Size... to change the

font size of the report. Edit | View Search

L\\) Set Font Size...

After you select the font size you want, click OK to
change the size of the font on the displayed
report.

Font size:

< o]
Cancel

Click View to move around within the report. Use

the following commands: ‘"’[ iew | Search
F

i irst P Ctrl+F
* To move to the first page of the report, select irst Fage rl+

First Page or press CTRL + F. TEErE el

* To move to the last page of the report, select Mext Page  Ctrl+N
Last Page or press CTRL + L. Previous Page Ctrl+P
* To move forward one page, select Next Page GotoPage.. Ctrl+G

or press CTRL + N.

* To move back one page, select Previous Page or press CTRL + P.

* To move to a specific page, select Go to page or press CTRL + G and then enter the

page number.

Click Search and select Find to locate a particular

name or string of text. The Find window appears. Llrlsea“h
Find...

Find Mext F3
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Enter the text string and click
Find. Press F3 or click Find Next
to find the next instance of that

string. The program will then
find and highlight it. Cancel |
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EL68, Manual Entry Report
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Real Time Log

NOTE: This section references functionality that is not supported with the current
voting system configuration
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650 Network Server Log

NOTE: This section references functionality that is not supported with the current
voting system configuration
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Part 7: Suspended Menu

NOTE: This section references functionality that is not supported with the current
voting system configuration
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